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LIGHTING CONTROL SOFTWARE

Operating Instructions

for GRAFIK Eye» LIAISON-« Software

LIAISON Software
letsyou . ..

PROGRAM the following:

GRAFIK Eye Control Units*
m Scenes-intensities and fade
times
m Load types—includes
non-dim options
m Temporary Mode switch setting
m Control Unit communication
assignments

m Temporary, on-line scenes

Accessory Controls*
m Control Unit communication
assignments

Power Panels*
m Control Unit and Zone assign-
ment for each circuit

m Load types for each circuit

Timeclock Events
m Real-time and astronomic event
scheduling

Super Sequence

m Automated, synchronized u
dynamic scene selection
throughout the system

INTERROGATE the system =
for:

m The above information |

m Number of Control Units and
Accessory Controls present in
system

m Control Unit type*

m Number of Control Units zones
(2-24)
m Accessory Control type

BACK UP an entire programmed
system, including Timeclock
events, for archival purposes.

* Requires the use of 3500 and/or 4500
series Control Units and GRX-PRG or
GRX-CI-PRG.

For use with 3100, 3500, 4100, and/or
4500 series Control Units. Requires
GRX-PRG or GRX-CI-PRG.
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GRAFIK Eye

LIAISON..

LIGHTING CONTROL SOFTWARE

reate or Edit a Project
from File

Installing GRAFIK Eye LIAISON

System Requirements:

In order to use GRAFIK Eye
LIAISON, you will need the
following:

HARDWARE

IBMe compatible PC,
Pentiume 266 MHz or higher
recommended

32 MB RAM

15 MB of free space on your
hard drive

VGA Graphics

SOFTWARE

Microsofte Windowse 95 or
later operating system, or
Microsofte Windowse NT
version 4.0 or later

LIAISON does not support
Microsofte Windowse Vista

CD INSTALLATION

m Quit all other applications,

including any anti-virus
programs by:

1. Right-clicking on its icon in
the System Tray and quitting the
program, or

2. Pressing Cntrl-Alt-Delete,
selecting the process, and
clicking on the button labeled
“End Process.”

Insert the GRAFIK Eye
LIAISON CD into the CD-ROM.

From Windows START menu,
select RUN.

In the RUN box, type the letter
for your computer’'s CD-ROM
drive (usually D:or E:), and
SETUP. Click OK.

After installation is complete,
click on the LIAISON icon to run
LIAISON.

To download the latest version of LIAISON,
visit our website at www.lutron.com.




GRAFIK Eyeo LIAISON.. Software Operating Instructions

START-UP SCREEN

GRAFIK Eye LIAISON Lighting Control Software can be used to Create, Edit, Go Online with, or
Back up a GRAFIK Eye system. Select the mode you wish to use:

Create or Edit a Project from File

This mode can be used without being connected to a GRX-PRG or GRX-CI-PRG. Select this
mode if: you are in the design stage of a project or wish to edit an existing project; you have
created a project and need to download the data for the first time; or, you want create a
project in your office for future downloading to a GRAFIK Eye system.

Go Online with System

Select this mode after you have transferred data using Create or Edit a Project from File to
monitor and operate your GRAFIK Eye system. This mode requires interfacing with the GRX-
PRG or GRX-CI-PRG (refer to instruction sheet P/N 040-135 or 040-228). See Page 18.

CREATE OR EDIT A PROJECT FROM FILE
FILE MENU

'}

(=~

Open

m If you have already created a job file, open that file using Open. LIAISON files have the extension “.lia”
and, by default, are saved in the same directory as LIAISON.

[

New

m From the File menu, select New. Select the type of system that you will be designing. There are three
options when creating a new file:

v
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1.

Timeclock Only

Schedule real-time and/or astronomic events for the entire system. Use the super sequence
for dynamic, synchronized scene selections throughout the system. Requires a GRX-PRG or
GRX-CI-PRG and 3100 and/or 4100 series Control Units.

. Programmable System

Includes all the Timeclock Only features, plus the ability to program all aspects of the system
operation using LIAISON.
Program all Control Unit information:

scenes (intensities and fade times), load types, communication assignments, and temporary
mode options.

m Program Control Unit and zone assignments to the circuits in the system.
m Program the Control Unit communication assignments for Accessory Controls.
m Also, program all the Timeclock events and super sequence events; available with Timeclock

Only.

Note: Programming Requires a GRX-PRG or GRX-CI-PRG. To program directly from a Control
Unit, a 3500 and/or 4500 series Control Unit is necessary.

. Lutron Lighting Wizard

If you are still in the process of designing your system, let the Lutron Lighting Wizard assist
you in creating a New file. After answering the questions presented by the Wizard and
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Operating Instructions GRAFIK Eyeo LIAISON.. Software

clicking Finish, those screens that apply to your project will be shown. If you want to add to
or edit your system at a later time, simply use the menus to reopen the needed screen. The
equipment required is based upon choices selected using the Wizard.

H Save
m From the File menu, select Save to save the file.

Import - GRAFIK Eye Timeclock (.GTC)

m GRAFIK Eye LIAISON can also be used to create Timeclock Only systems. Timeclock systems that
have been created by GRAFIK Eye Timeclock (P/N GRXTC-WIN) can be imported to LIAISON. From
the File menu, select Import -> GRAFIK Eye Timeclock (.GTC). After selecting the file to import,
click on OK. The file extension will be changed from .gtc to .lia and the imported file will be opened
for editing. The original file created by GRAFIK Eye Timeclock will not be changed.

% Print

m From the File menu, select Print to print information about the currently opened file. All system infor-
mation or selected information can be printed. Select the information to be printed and then click OK.

Exit

m To exit LIAISON, select Exit from the File menu. If changes have been made to the currently opened
file, or a new file was created that has not been saved, a prompt to save will be issued before exiting.

VIEW MENU

Enter Project Information

By default, the Project Information screen is shown every time a new file is created. This information
can be viewed or edited at any time. From the View menu, select Project Information.

m For future reference, enter the job name, location, and descrip- [
tion in the corresponding boxes.
. L . Project Nam
m Enter the name of individuals and companies for whom the 2 Wl
system was designed. Include addresses for future reference. Descion H
. . =
m Click Done to exit the screen. Desian By: Design For:
Mame:[Joe Designer Mame: [Nancy Customer
Compary: [Uighting Designlne. | [ Compare[
tddiess:[Blon. OH =] | | Addess[Coopersbug. A <]
o o
Set Preferences

Customize LIAISON by setting preferences for the user and

hardware interface. Preferences

for toolbar views, desktop color, and communication settings are set by selecting
Preferences from the View menu.

m Toolbar. The toolbar below can be displayed by selecting “Buttons Without Text” from the
Preferences screen. Also, “Large Buttons With Text” and “No Buttons” are options in the
Preferences screen. The toolbar provides a shortcut means of selecting menu items.

NMEEE EmE [Es EE] S
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m Desktop Color. Change the default color of the LIAISON desktop by selecting a color from the
palette. The selection will be saved to an initialization file and used every time LIAISON s run.

m Communications Type - Specify how LIAISON will communicate with a PRG box. GRX-CI-PRG
supports RS232 and Ethernet communication. LIAISON versions 4.0 and later support both RS232
and Ethernet communication. The “DevicelP” button launches Lutron’s Ethernet device discovery
program, installed from CD separately. This program enables you to set and get the IP information
from GRX-CI-PRG units that are connected over Ethernet and connected on the same Ethernet
switch (or hub), or connected directly to the PC.

m Communications Port - If serial communication is present, transferring data to the GRAFIK Eye
system requires the use of a PC serial COM port. From the Preferences screen, you may select the
COM port through which data will be transferred. The selection will be saved in an initialization file and
will only need to be set the first time you use LIAISON to program your system or if you change the
hardware configuration of your PC. The COM port can also be selected from the Set COM Port of
the Online Options menu.

m Device IP Information - If Ethernet communication is selected, you must specify the IP address, Port
number, and login of the GRX-CI-PRG box from the Preferences screen. The following is the default
setting of a GRX-CI-PRG:

IP Address: 192.168.250.1
Port Number: 23
login: nwk

Advanced

m Set redirection connecting time - By default port redirection connecting time is O. If a longer
connecting time is needed (i.e the user tries to use LIAISON to control a GRAFIK Eye system via a
network by network-enabling the serial device or via telnet to a remote location), the user can click
Advanced button and specify the connecting time via the Connection and Communication Time
screen. This time is used when establishing communication.

m Set response timeout - By default the response timeout is set to 0.5 second. During
communication, LIAISON will wait for a response from the PRG after sending out a command.
LIAISON will stop waiting if it receives a response or times out.

m Log communications - If this option is checked, the communication between LIAISON software and
the PRG will be logged to a file. Note that this option may slow down the communication process
and should be used for troubleshooting only.

By default the communication will not be logged. If you want to log communication, reselect this
option each time you start LIAISON.

The log file is named “LiaCommunication.log” and is located in the LIAISON application directory.
New records are appended to the log file. If you need a clean log file, you can delete or rename the
existing log file and the software will create a new log file for you.

NOTE: LIAISON is designed to communicate with the GRX-PRG, GRX-CI-PRG or GRX-RS232

via serial communication or Ethernet. If the user decides to network-enable the serial device, the
communication quality and port redirection connecting time may vary depending on the system setup
(i.e. the network adapter, device server, redirector software, operating system, etc.). Not all port
redirector software and device servers will work with LIAISON. It is the user’s responsibility to test the
communication.

#<LUTRON. 4



Operating Instructions GRAFIK Eyeo LIAISON.. Software

@ Enter Geographical Location € 5ystem Locatian =
5(5_’_5:1”5:';'::;0; Lacation Cavntry State City
. . . . ¥ Select from default locations nited States T i iladelphia i
The geographical location of a job must be defined | | ©ietmetien finwsse e <l pusine ]
if any astronomic events are to be scheduled. Loticde [0 Longude [21 07 TmeZone RIS
Daylight Savings Time Data
1. Select the Location item found in the View Daylght Savings Carrectin Amaurl -
menu. Starting Manth ,—L| Ending Manth ’—L‘

. . . . Starting Day Of Week. ,—L| Ending Dap Of Week ’—L‘
2. Select the city where the job is located using the |  sawctmoimerns [z] Edmabsoivens ]

pull-down lists for Country, State (if applicable), Staring T [ZWan | Endvaline e
and City. The location value, time zone, and
daylight savings information associated with the
chosen city will appear on the screen.

3. If the desired city is not present in the list, select “User Defined Location” and enter the latitude
and longitude in the appropriate locations on the screen. Latitude and longitude are in units of
degrees. For example, 12.5 = 12 degrees, 30 minutes. Now enter the correct time zone and
Daylight Savings information.

4. Click on Done to return to the start-up screen. Select Save from the File menu to save the
changes.

SETUP MENU

g

Specify Control Units

NOTE: Programming directly from a Control Unit requires 3500 and 4500 series Control Units.

Control Units are specified based upon the type of system that you are designing. If Timeclock Only
was specified when the file was created OR the Wizard decisions did not require programmable
Control Units, models will be limited to 3100 and 4100 series Control Units. If Programmable System
was specified OR the Wizard decisions included creating scenes for GRAFIK Eye Control Units, the
model list will include 3500 and 4500 series Control Units.

1. From the Set Up menu, select Specify 4a Control Units in this Sysien HEE
Control Units. Click on the menu under o, ot your sontl i e i corm it
the Model column to select or change the Model [addiess|  Descuption [ A1 [ 2 [ A3 [a4 [5 [ 46 [a7 (a8
GRx-3504 Al Conference Room
GRAFIK Eye model numbers for your sys- e B e
‘tem Mot Used “UNITB o0 T T T T
Mot Used “UNIT4 O ollg 1 1
2. Use your pointer to highlight the Description | Eﬂ:llz A
section and name your Control Units by NotUsed |Gl UNIT 7 o olololog O
entering a description, such as “Conference L= B SIS

Room” or “Lobby”, on the line corresponding
to each Control Unit.

3. If the Control Units are 3500 and 4500 series, check off the addresses of all the Control Units you
want each Control Unit to “talk to” by clicking each corresponding box. For example, click A2 on
the first line if you want Control Unit A1 to “talk to” Control Unit A2.

4. Once you have specified each Control Unit, click Done to exit the screen.

If Timeclock Only was specified when the file was created OR the Wizard decisions did not
require programmable Control Units, skip the rest of this Section and proceed to Timeclock

Menu on Page 13.
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| Specify Accessories (For Programmable Systems using GRX-PRG or GRX-CI-PRG Only)

Many GRAFIK Eye systems include Accessory Controls that allow for remote control of Control
Unit(s). These accessories must be told which Control Unit(s) to “talk to.” Some accessories are pro-
grammed such that all buttons “talk to” the same Control Unit(s). Others, such as partition controls,
are programmed on a button by button basis. These differences are based upon Accessory model
and functionality. For this reason, Accessory Controls must be specified and then programmed.

NOTE: Model information and functionality will not be programmed. This information is used to deter-
mine whether programming will be for all buttons or each individual button.

IMPORTANT! Accessory Control details are only available from accessory controls with a minimum
code revision. To determine the code revision level, inspect the back of the accessory control. If you
have questions, please contact the Lutron Hotline for assistance.

Minimum Code Revision of Accessory Controls For Getting Details

Type Minimum
Standard Accessory Control
Shade Accessory Control
Accessories. Click the Accessories tab on

the “Accessory Controls in this System” form.
Click on the drop down menu under the Model

Code Revision
2-0
1-1

I

Accessories Contrallers

Select the Accessory Controls and functions for pour system.

Model Address Function Description
N 1

ADDRESS 1
ADDRESS 2
Address 3
Address 4

Finetune

column, and select the Accessory Control model
numbers for your system.

Scenes1-4

Hone

Hire

- Programming | nterface I R5232 Programming Interface
Check the

|an Used
[ GReFRG

. The functions listed for each address are
dependent on the model selected in the first
column. Click on the drop down menu under
the Function column, and select the function for
the Accessory Control. The button table at the
bottom of the screen may change from “ALL”
to individual buttons based on the selected
function.

addresses of all
units you want
each Accessomny
Control to *'talk.

Button| A1 | A2 | A3 | A# | A5 | AB | A7 | AB | e
Gl A2 I I A A T
Done

NOTE: The bottom of this screen may have a different appearance for certain Accessory Controls.

3.

NTGRx=-45 Scene Selection Control

Scene selection, raisedower and off on one or mare
Contral Uit

Name your Accessory Control by highlighting the Description section and entering a description,
such as “Conf Rm Entrance” or “Conf Rm Podium”, on the line corresponding to each Accessory
Control. Descriptions are for reference only and will not be downloaded to the Programmer
Interface (GRX-PRG or GRX-CI-PRG).

. Indicate which Control Units you want each Accessory Control to “talk to” by checking each
corresponding box. For example, click A1 on the first line of the Button table if you want the
NTGRX-4S Accessory Control at Address 2 to “talk to” A1.

. For Fine Tuning Accessory Controls and Shade Accessory Controls, individual zone control is
available. To program which zones of a Control Unit you want the Accessory to control, click on
the corresponding box. This action will bring up a list box of zones for the selected Control Unit.
Select or de-select zones by clicking on the zones of the list box, or select / de-select all zones of
the Control Unit by clicking the Select All / Clear All button, and then click Done to exit the screen.
(SG-8WD is a dual 3-button shade control, the top 3 buttons and the bottom 3 buttons can be
programmed separately on a zone by zone basis).

6.
LUTRON.

Once you have specified each Accessory Control and Controllers, click Done to exit the screen.
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Specify Controllers (For Programmable Systems using GRX-PRG or GRX-CI-PRG Only)

v
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. From the Set Up menu, select Specify Accessories. Click the Controllers tab on the “Accessory

Controls in this System” form. Click on the drop down menu under the Model
column, and select the Controller model numbers for your system.

. The functions listed for each address are dependent on the model selected in the first column. Click

on the drop down menu under the Function column, and select the function for the Accessory
Control.

. Name your Controller by highlighting the Description section and entering a description, such

as “Conf Bm Entrance” or “Conf Rm Podium”, on the line corresponding to each Controller.
Descriptions are for reference only and will not be downloaded to the Programmer Interface (GRX-
PRG or GRX-CI-PRG).

NOTE: The bottom of this screen may have a different appearance for certain Accessory Controls.

. Using the table at the bottom of the screen to program the selected controller.

GRX-SVC: Specify a zone to control.
GRX-GC: For each channel of the unit, specify a zone to control.
GRX-CCO (Zone mode):  For each relay group of the unit, specify a zone to control.

Click on the drop down menu under the Control Unit column of the bottom table, select the Control
Unit that you want the selected unit/channel/relay group to “talk to” from the list.

Click on the drop down menu under the “Zone” column of the bottom table, select the zone that you
want the selected unit/channel/relay group to “talk to” from the list.

GRX-CCO (Scene mode):

Indicate which Control Units you want the controller to “talk to” by checking each corresponding box.
For example, click the box under A1 if you want the controller to “talk to” A1.

5. Once you have specified each Controller and Accessories, click Done to exit the screen.

NOTES:

Each Controller in a system must be assigned a unique Controller address by setting the DIP switch-
es on the unit. There are a maximum of 8 Controllers per system. (These Controllers do
not occupy the 16 standard Accessory Control addresses).

GRX-SVC, GRX-GC and GRX-CCO (Zone mode) can only control zones on GRAFIK Eye Control Units
with software revision 7-0 or higher, these controllers will not function correctly with Control Units with
lower software revisions.

Each GRX-SVC unit, each channel of a GRX-GC, each relay group of a GRX-CCO (Zone mode) can
“talk to” one zone in a system.

LUTRON. 7
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E Program Control Units (For Programmable Systems using GRX-PRG or GRX-CI-PRG Only)

In addition to specifying Control Unit model numbers and communications, scene names, zone names,
scenes, and load types are all programmable using LIAISON.

1. Scenes are made up of zone intensities and fade times. There are 16 scenes plus an Off scene for
each Control Unit.

2. Light intensities for all scenes except Off can be adjusted from 0 to 99 or unaffected (UA).
AC shade positions for all scenes can be set to Open, Close or unaffected (UA).

Sivoia shade positions for all scenes can be set to Open, Preset 1, Preset 2, Preset 3, Close or
unaffected (UA).

The light level or shade position of an unaffected zone will not change when that scene is selected.

3. Fade times are adjustable for all scenes and can range from 0 to 59 seconds or 1 to 60 minutes. The
fade time is the time it will take for the zone intensities to raise or lower to the scene’s preseat level
from their current intensities.

4. Load types are the type of fixture(s) that will be controlled on a zone-by-zone basis. It is important to
specify the correct load type for each zone to achieve the best dimming performance.

m From the Set Up menu, select Program Control Units. Click on the list box in the upper left-hand
corner of the window and choose from the units specified previously. For example, click on Confer-
ence Room to program the Conference Room Control Unit.

Zone Names

m Click on the Zones button :J Q to label your zones. Enter the names of your zones, e.g., “Downlights”
or “Sconces”, in the Zones text boxes.

Presets Fade window Master Raise/Lower buttons

we Program Control Units

m Click on the Presets button to set up your
scenes. Select the scene you want to create in
the Scenes list box. To change the name of the
scene, highlight the Scenes list box and enter  zoe
the new scene name. E§§§£S
To create a scene, set the intensities of the Fields

or

zones in that scene by clicking on the Zone  entering
Raise and Lower buttons of each zone OR by

typing in the value of intensity in the box below

each zone. For example, for Scene 1, click on

the Zone 1 Raise button to increase the light
intensity of that zone or type in 90 in the box if g |
you want the intensity at exactly 90%. Repeat

the procedure for each zone in the scene.

Lighting Zones:
Clicking on Raise/LLower button or typing in intensity value to set lights intensity.
AC Shade Zones:
Clicking on Raise/Lower button or typing in the following key to set shade position (Open and Close),
Or: Typing in “O” or “0” for Open
Typing in “C” or “c” for Close

#<LUTRON. 8
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Sivoia Shade Zones:

Clicking on Raise/Lower button or typing in the following key to set shade position (Open, Preset 1,
Preset 2, Preset 3 and Close),

Or: Typing in “O” or “0” for Open; Typing in “C” or “c” for Close
Typing in “1” for Preset 1; Typing in “2” for Preset 2; Typing in “3” for Preset 3

Fade Time

m Modify the Fade Time for the scene by clicking on the Raise/Lower buttons in the Fade box OR by
typing in the exact value in the Fade window.

m Follow the same procedure for each scene.

me Program Conlrol Unils
Unit Cumently Being Edied Zos Presets  Losd Types Temoorsry Mode

m Fade time will not be applied to non-lighting zones. T B | =
Select Load Types e ————
m T0 select Load Types, click on the Load Types button

in the Program Control Units window.

m Click on the Raise/Lower buttons of each zone until
the correct number of LEDs corresponding to the
appropriate load type (as defined in the chart at the —

bottom of the screen) are lit. For example, for elec- “’&Tg““‘%uw T e =
tronic low-voltage loads, use the Raise/Lower buttons Eﬁf“;{gﬁ”l“‘“w I I E
to light two LEDs. Repeat for each zone. oo |

Load Type Legend

LED Display Load Type Description GRX -3xxx GRX-4xxx Integrale
GXI-3xxx

GRX units: Yes Yes Yes
Incandescent
Magnetic low voltage
HP 2, 4, 6 loads (120v

supply only)

Integrale:
Magnatic Low Voltage

(MLV)

GRX units: Yes N/A * Yes
Electronic low voltage
Lutron Hi-lume or Eco-10
fluorescent
Integrale:
GRX-TVI

Tu-wire compact fluorescent | rev 5-5 or N/A * N/A
higher

$:LUTRON. 9
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Neon/Cold cathode Yes N/A * Yes

Non-dim (last on, first off) Yes Yes Yes

Non-dim (first on, first off) Yes Yes Yes

AC shade rev 7-0 or rev 7-0 or N/A
higher higher

Sivoia shade rev 7-0 or rev 7-0 or N/A
higher higher

Unassigned/Non Dim N/A N/A Yes

This setting is the default for

GXI Control units.

Auto Phase N/A N/A Yes

Last LED ON: Reverse/

Trailing edge

Last LED OFF: Forward/

Leading edge

Note: LIAISON will always

display Reverse/Trailing edge

$:LUTRON. 10
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Electronic Low Voltage (ELV) | N/A N/A Yes
Incandescent
GRX-ELVI
E 0-10v ballasts N/A N/A Yes
E DSI compatible ballasts N/A N/A Yes
DALI (intensity broadcast N/A N/A Yes
only) ballasts
E PWM ballasts N/A N/A Yes

Key:

Yes: All versions support the LoadType

Rev #: All versions of that code rev or higher

* GRX-4000 units should be set to Load Type 1 for those Load Types

Temporary Mode

m T0 set the Temporary Mode, click on the Temporary Mode button. “

m Use the Master Raise/Lower buttons to select a Temporary Mode: Sd to Save by default; Sb to
Save by button; Sn to Save never; 4S8 for Scene selection and Master Raise/Lower only; and bd for

Buttons disabled. The Temporary Mode selected appears in the Fade window. Press F1 for descrip-
tions.

#<LUTRON. 1
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i Program Power Panels (For Programmable Systems using GRX-PRG or GRX-CI-PRG Only)

If your system requires the use of GRAFIK Eye dimming or switching panels, use LIAISON to
program Control Unit and Zone assignments plus the load type for each circuit. It will be necessary
to Program Power Panels if 4100 or 4500 series Control Units have been included in the system.
Each circuit of a dimming panel receives its light level from a Control Unit and Zone in the system.
Each circuit will have an individual Zone assigned; however, multiple circuits may have the same Zone
assignment. Load types are the type of fixture(s) that will be controlled on a zone-by-zone basis. It is
important to specify the correct load type for each zone to achieve the best dimming performance.

NOTE: Power Panels must be uniquely addressed to allow for programming. If you have any
questions regarding panel addressing, circuit capacities, or load types, please contact the Lutron
Hotline for assistance.

IMPORTANT! Power Panel details are only available from circuit selectors with a code revision
level of 2-50 or newer. The code revision is available on the circuit selector of the panel. If you have
questions, please contact the Lutron Hotline for assistance.

From the Set Up menu, select Program Power Dimmer Panel Assignm I i & B3
. elect the panel to proaram loa
Panels. Choose the Panel to program by specify- schedules
ing the address in the table at the top of the screen. st |
For example, click on Address 1 to program the
Conference Room GP4. E M R
. 2 C31 Meon Cove Blue 31 Meon, Cold Cathode
To modify the name of the panel, select the Name L~ e I
4 C33 window Shades 81 AC Motor

cell of the panel address you are modifying. Enter in
the new panel name. This name is for reference only
and will not be downloaded to the system.

Ta change how the load schedule is ordered, click on a column header
To modify the number of circuits in a panel, select Sortod by: Lutton Circuit 1 Dors
the Number of Circuits cell of the panel address
you are modifying. Use the pull-down list box to select the number of circuits for the panel being pro-
grammed. If the new number of circuits is greater than the original number, the circuits will be added
to the current load schedule. If the new number is less than the original number, the circuits will be
deleted. If any circuits to be deleted have already been programmed, you will have to confirm the
deletion when prompted.

The load schedule table at the bottom of the screen lists the circuits in the panel and allows the user
to program the Control Unit, zone assignments, and the load type for each circuit. In addition, cus-
tomer circuit information can be provided for reference. Select Customer Circuit # or Customer
Circuit Name to enter customer-specific information.

Click on the Control Unit cell and select from the pull-down list the Control Unit of the Zone that

will be dimmed by this circuit. Only those Control Units that have been included in the system (see
Specify Control Units) will be listed. After selecting the Control Unit, click on the Zone cell and select
a zone from the list. This is the zone that will control the light level of the loads attached to the circuit.

Finally, click on the Load Type cell and select from the pull-down list the load type of the fixtures of
the circuit. The load type must be specified at the power panel in addition to specifying load type on
the Control Unit (see Program Control Units).

Program the remaining circuits of the panel in the same manner. To add additional panels to the sys-
tem, click Add New Panel. A new panel will be added to the bottom of the panel table.

Once you have programmed all the Power Panels, click Done to exit the screen. Remember to save
your changes while working by selecting Save from the File menu.
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TIMECLOCK MENU

. NOTE! For each schedule, there is a
E Create a Timeclock Schedule maximum of 60 events allowed.

Select Schedules from the Timeclock menu to open the Schedule Events screen. Follow the steps
below to define a schedule.

1. Select a Schedule. There are four schedule options: Weekday, Weekend, Special 1 and Special
2. The Weekday and Weekend options allow schedules to be defined that will run every weekday
or every weekend day by default. The Special 1 and Special 2 schedules are used to define sched-
ules of events for a unique day (e.g., Holiday, Party, etc.). Select a schedule to program by clicking
on an item from the “Schedule” list.

2. Select Event type: Time of Day or [ Schedule Events - Weekday M= B
i i Click an the list bel : . Ach

Astronomic - Select the Time of Day or|gi, = 505 Time of Day | Astonomic | Sl 3

Astronomic tab of the schedule. If the | . sshedie R = |{scene uncoo

Time of Day tab is selected, events can yreckday " SELECT SCENE 1 ZONE UNLOCK

be scheduled to occur at a particular Special T ik

time of day or night. Astronomic specil? ey GO | SUFER SEQUENCE O :‘
- . 8 Lobby =

events can be defined by selecting the EE—— LI EED | - cometurs

Astronomic tab. Events can be set to 900 A6 Canference Floom
occur up to 2 hours before or up to 2 Type & new time to e

add ta the event list

hours after sunrise OR sunset. The time _ ol
scale corresponding to the event type Enter Hew Time P Lobby
will be listed in the schedule. Ly

NOTE: For both event types, the time M 40P b Dore
resolution is to the nearest minute.
Figure 1 displays Time of Day events. Figure 1. Time of Day Events

All four schedules can include both

real-time and astronomic events (though they cannot be viewed simultaneously on the Schedule
Events screen).

3. Add an event. The Schedule Events screen utilizes the “drag and drop” method of adding items
to alist. To add an event, begin by adding an action to the list of events. Select an action in the
“Actions” list. Click on this item by pressing and holding the left button of your mouse. Continue
to hold the left button down and drag the action to a time in the Time of Day or Astronomic
event list. To drop the action, release the mouse button when the time for the event is highlighted.
Actions can be dropped on times or other actions. For example, to change the action of a
previously defined event, you would drag and drop the new action onto the original action.

After adding an action, you must specify at which GRAFIK Eye Control Units the action will occur.
The only actions that do not require a Control Unit are “SUPER SEQUENCE ON” or “OFF.” To add
a Control Unit or Units to an action, click on the Control Unit in the “Control Units” list. Press and
hold the left button of your mouse and drop the Control Unit to an action in the list. Control Units
can be dropped on actions or other Control Units. If the Control Unit is already included in the
action, it will not be added a second time. Multiple Control Units can be listed under an action by
dragging additional items from the “Control Units” list to an action in the event list.

NOTE: Only those Control Units that have been included in Specify Control Units will be available
for selection.

NOTE: To schedule a “START AFTER HOURS MODE” or “CANCEL AFTER HOURS MODE” event,
After Hours Mode must be enabled.

4. Change an event time. To change the time that an event will occur, again use the “drag and
drop” method. Click on the action in the event list. Press and hold the left button of your mouse.

$:LUTRON. 13
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El Create a Timeclock Schedule (continuation)

Drag this action to the new time in the event list. If the time is not listed, follow the procedures
below to add the new time and then relocate the action.

5. Add New Time. If you wish to schedule an event for a time not included on the list, you will need
to add the time. In the “Enter New Time” text box, type the time of the event. For Time of Day
events, type in the time, formatted based on the computer’s international settings. For Astronomic
events, type in the desired amount of time Before or After sunRise or sunSet (up to 2 hours) fol-
lowed by the appropriate code: BS, AS, BR, AR. After entering the time, click on Add New Time.
The new time will be added to the list. For Time of Day, if AM or PM was omitted (but included in
the computer’s international setting), the AM or PM extension will automatically be added based on
the current event selected in the list.

6. To remove any events, highlight the event and then select Delete from the Edit
menu. | e
‘Weekend
7. To copy one schedule to another, click on the Copy Schedule button. The Shecd2 || |3pead
Copy Schedule screen gives the user the option to copy real-time events, e
astronomic events, or both, to another schedule. There is also the option to € Fea T Evente Ony
overwrite the events or to append the events to the end of the “Copy To” & o e
SChedU|e [Eogy IDplioEn.s ook .
* Delete Existing Events First
8. The “Copy From” list is the schedule of events that will be copied. The “Copy ||« s ene
To” list is the schedule to which the events will be copied. Use the options to Done

set which events will be copied. Click and drag a schedule from the “Copy
From” list to a schedule in the “Copy To” list. When the copy is complete, click on Done.

9. To change schedules, select a new item from the “Schedule” list. When the Weekday, Weekend
and any Special schedules have been defined, click on the Done button to exit the Schedule
Events screen.

10. Select Save from the File menu to save your system changes.

E Default Schedule for Day

Friday

By default, weekday schedules will run Monday through # Default Schedule for Day ]
Friday and weekend schedules will run Saturday and Sunday. Weskend ‘Weskday Special1 Special 2 No Schedule
If your system requires modifications to this default week Sunday 9 C e c o
definition, proceed as follows. Monday c & r c ~
Tuesday I ol e s >
To change the week definition, select Default Schedules Wednesday € g o o o
from the Timeclock menu. The days that constitute week- [ : : : : :
ol r~ r~ ol ~

days and weekend days can be modified in the Default
Schedule for Day screen. For example, to run the weekend
schedule every Monday select the “Weekend” button. e

When modifications have been completed, click on Done to return to the main screen.

Saturday

Select Save from the File menu to save the changes.
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After creating and transferring a schedule of events, the
weekday and weekend schedules will run, by default,
every weekday and weekend, as defined in the Default
Schedule for Day screen (see Default Schedule

for Day). Special 1 and Special 2 schedules can be
used for special events or exceptions to the default. In
addition, schedules can be suspended or overridden
using Calendar. Suspending scheduled events on a
specific day will only suspend the schedule for that day.
Any scheduled events will resume the following day.
Exceptions are saved by date in memory indefinitely,
therefore, annual maintenance may be needed for
holidays that do not fall on the same day every year
(e.g., Thanksgiving, Labor Day, etc...). Fixed-date

View and Modify Calendar Exceptions

holidays, such as New Year’s Day, do not require maintenance.

1. Select Calendar from the Timeclock menu.

2. The Schedule Exceptions screen displays a one year
calendar. To add an exception, drag a schedule from
the list and drop it on any day of the year.

3. To view the events in a schedule, select the schedule
in the list and click Show Events.

4. To view an individual month, the button in the top

right corner of each month can be selected. Using the

g Schedule Exceptions M= E
To view a single
[ - ZMaarch 413353 slir[ [ Apiil 113332 EJ [ May1398 [ ot ek o the
8 910 111213 14 S10 11 3 4 5 § 7 g g |bton L]
151617 181920 21 | 121214 1516 17 18 10 11 12 13 14 15 16
222324252627 28 192021 2232425 171819 2021 22 22| reate schedule
29 30 31 26 27 28 29 30 %;1 25 26 27 28 23 30 | excentions by
\:Ir_aggmgand
[ June1938 [ || Jup1338 [ | August 1938 [ | dropping a schedule
12 345 B 3 4 1 | fram the fist below to
78 910111213 7 011 23 4 5 F 7 8| anydayoftheyear
141516 17 18 19 20 | 1 41 718 91011121314 15 | e
212223242526 27 1 1 2 425 151718 192021 22 S
25 29 30 2 g 2 1 23 24 25 26 27 28 29
a0 31 Special 1
Special 2
[ September 1935 [ || October 1938 [ November 1398 [ | |Suspend
12345 3 123 4567
E 73 3101112 4 5 E 10 8 910111212 14 | Show Events
13 1415 16 17 18 19| 11 12 13 141 17| 1516 17 18 19 20 21
202122232425 26 181920 21 2 24 222324 B EIT B | | egerd
27 2329 30 25 26 27 28 2 3 293
Weekday
Weekend
[ December 1938 I:[ [ January 1933 EI [ February 1339 IE Special 1
12345 2 12 3456
E 7 3 3101112 3 45 7 8 9710711213
131415 16 17 18 19| 1011 12 1314 15 16 14 15 16 17 18 19 2
202122 232429 26| 171819 20 21 22 23 21 22 23 24 25 26 27
27 2329 30 31 242526272329 30 28 e
3 =
g April 1998 M= E
[ April 1998
1 2 3 4 Wweekday
“weskend
5 [ 7 8 9 10 1 gpec!a:;
Special 1 pecial
12 13 14 15 16 17 18 Suspend
Show Event
18 20 2 2 23 b} % = Everte
% 27 28 29 a0

month view, you can add exceptions to every day or every weekday in a single “drag and drop”
action. For example, to create exceptions for every Sunday, select the schedule, drag and then
drop on “Sunday.” To create exceptions for the entire month, select the schedule, drag and then

drop on “April.”

5. To delete an exception, highlight the day and select Delete from the Edit menu.

6. When the calendar modifications are complete, click on Done to return to the main screen.

1
23

Create a Super Sequence

A Super Sequence is a collection of up to 60 system scene selects, called steps, and their corre-
sponding hold times. The elements involved with a Super Sequence event are the scene, the

selected GRAFIK Eye units, and the Hold Time.

To define a Super Sequence, select Super Sequence from the Timeclock menu.

Set a Step. Steps that have not yet been defined will have “No Step/End” in the Scene to Select
column. From the first unused step, select the desired scene number from the pull-down list. Select
the Units at which the scene will be selected by checking the appropriate Control Units.
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NOTE: The selected scens will be activated on
eaCh Of the ContrOI Unlts SeleCted for that Step For Frogram your super sequence by selecting the scene far the step. Then click the contral units at which

example, if Scene 2 and Control Units 1 and 2 (A1 | 5 e bt i st uhaber e suer oo vl o res arc i ot cominsensh
and A2) are chosen for a step, Control Units 1 and |
5

LI

2 will go to their respective Scene 2 levels, using P °cere 2 ) IV 0 T A I W ®: Om
the tive Scene 2 fade 1 hen the step |REmcor, 4 4 L J 8 e On
eir respective Scene 2 fade times, when the step e 1 20 B N S B B
occurs. 0 = D D B e D
| | . ! Ml ; : L) e
Set a Hold Time. The Hold Time defines the j :Di;zj;j ) T T T i W : gzgz
; ; ; : i I D D e D
amount of time the system will wait before executing | i sipnd S EL L e L L
the next Super Sequence step. The range of hold 15:] :ztnj: FlEEE : @s Om
times are 0 to 60 seconds and 0 to 99 minutes. If a i w5 T ®:On iz

* Run Sequence and Loop

Hold Time of O seconds is used, that step and the
next step will occur simultaneously.

" Run Sequence Once and Stop

NOTE: The hold time begins as soon as the scene is selected, not after the scene has completed its
fade. If your application requires that a scene remains for a given time after it has completed its fade,
you must add the scene’s fade time to the hold time. For example, you require that Scene 1 remains
for 20 seconds after it has completed its fade. Scene 1 has a fade of 5 seconds, therefore, a Hold
Time of 25 seconds should be set.

Editing Steps. From the Edit menu, use the Cut, Copy, Delete, and Paste options to edit steps of
the Super Sequence. To edit a step, select from the Step column and choose the appropriate edit
function. In addition, an edit menu will appear by clicking the right mouse button when an event is
highlighted. This pop-up menu also includes Insert. Inserting a step will shift the highlighted step and
all steps following down one step and paste the copied step to the current step. If a step 60 has been
defined, it will be shifted off the list.

Click on Done to leave the Program Super Sequence screen.

Select Save in the File menu to save the defined Super Sequence.

After Hours Mode

After Hours Mode of the GRX-PRG or GRX-CI-PRG and LIAISON software allows the user to

create timeclock schedules that minimize energy usage during off-peak periods or periods of non-
occupancy. After a user-defined delay, following the start of After Hours mode, a user-defined scene
will be selected. Any scene selection during this delay period will reset the delay period and “lease”
the lighting for the space.

The user-defined delay can range from two minutes to two hours. After Hours mode can be cancelled
via a scheduled event. After Hours mode can be initiated and cancelled on any combination of
Control Units. The delay time is the same for all Control Units. The scene to be selected is the same
for all Control Units.

After Hours Scene

A user designated scene that is automatically selected after a user-defined delay following a scene
selection during After Hours Mode. While in After Hours mode, the system can automatically return to
the desired energy efficiency level during periods of non-occupancy or off-peak usage.

After Hours Timeout

A user-defined time period, between two minutes and two hours, that the system will stay in a
selected scene during After Hours Mode. When the time expires, the system will automatically select
the After Hours Scene.
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m Configure After Hours Mode:
1. In Edit Mode, from the Timeclock menu, select After Hours Mode.

2. On the After Hours Mode screen, check Enable After Hours Mode to enable the After Hours
Mode; or uncheck the box to disabled it.

3. Specify the After Hours Timeout. The valid timeout range is 2 minutes to 2 hours. Default timeout is
2 hours.

4, Select an After Hours Scene. After Hours Mode Scene can be any Scene from Scene 1 t016 or
Scene Off, the default is Scene 15.

5. Click Done to exit the After Hours Mode screen
m After Hours Mode events:
Start After Hours Mode
Cancel After Hours Mode
These events can be scheduled as timeclock events.
m View System After Hours Mode Configuration:
In online mode, from Online Options menu, select After Hours Mode.
NOTE: After Hours Mode requires a GRX-PRG (with minimum code revision of 4.2) or GRX-CI-PRG.

Assign Controls for Super Sequence and Timeclock Events

GRAFIK Eye Accessory Controls, NTGRX-2B-SL and GRX-AV, can be assigned to manually control
the Timeclock interface by providing the following functions: start, pause and resume a Super
Sequence, and turn on or off Timeclock events.

m To assign an Accessory Control, select Wallstation Control iéalltation Corkiols

from the Timeclock menu. Choose the appropriate system Super seduence Triecock Eens
address for the Accessory Control and the Wallstation type, = [EEEEE [

NTGRX-2B-SL or GRX-AV. E

NOTE: The Accessory Controls must have the function DIP — —_— B
Switches set for Scene 1 selection. START  [Wore = ON =
FAUSE m OFF lﬁ

m Assign a button for the function required. RESUME [E 3]

Done

m Select Save from the File menu to save the changes.
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ONLINE OPTIONS MENU
Communicating with the GRX-PRG or GRX-CI-PRG Interface Control

Establish communication with the Interface Control. Review the
GRX-PRG or GRX-CI-PRG instruction sheet before attempting to
communicate with the Interface Control. For serial connection, verify
that the provided cable is connected on the Interface Control to a
COM port on your computer.

For Ethernet connection, verify that the PC and the GRX-CI-PRG are
connected via an Ethernet network.

NOTE: At this time, it is assumed that all system wiring has been
completed correctly.

For Serial connection, select Set COM Port from the Online Options @
menu or Preference form. Select the COM port that corresponds to
the port on your computer to which the GRX-PRG or GRX-CI-PRG is connected.

For Ethernet connection, specify IP address, Port number, and login of the GRX-CI-PRG from the
Preference form.

Click the Advance button on the Preference form to open the Connection or Communication
Time form. Specify Connection Timeout and Response Timeout from this form.

Select Establish Communication from the Online Options menu. LIAISON will attempt to locate
a GRX-PRG or GRX-CI-PRG Interface Control. If one exists, and is connected properly, you will be
notified that the unit was found. If an error message is displayed, check the wiring to the Interface
Control and the PC.

Transfer Data to the GRX-PRG or GRX-CI-PRG Interface Control

Once communication has been established between the PC and the Interface Control, select Trans-
fer Data from the Online Options menu. The Transfer Options screen allows the user to selectively
transfer portions of data to the system. This feature is useful when only a portion (e.g., Timeclock
events) of the system information has been modified. An initial transfer of any system requires that

all system information be programmed and will take longer than selectively transferring data. After
selecting OK, the GRAFIK Eye LIAISON Compiler screen will contain messages pertaining to the
current status of the transfer. The messages shown during compilation will be dependent on the
options chosen in the Transfer Options screen. After the data has been compiled and transferred,
the message will read “System Compiled Successfully.” After transferring data, you will be prompted
to switch to Online Mode. If you would like to monitor the currently installed system, switch to Online
Mode; otherwise, if additional editing to the system file is required, remain in the Edit Mode.

Congratulations! You have completed programming using LIAISON Lighting Control Software for
GRAFIK Eye. To monitor the status of your system, continue to the next section, Go Online with
System.

GO ONLINE WITH SYSTEM

After you have transferred data using the first mode (Create or Edit a Project from File), select this
mode to monitor and operate your GRAFIK Eye system. System status is available for each Control
Unit in the system. System status includes current scene selected, Timeclock status,

Super Sequence status, and scheduled events. Monitoring an installed project does not require a
database file (files with extension .lia). The only system information that will not be available will be
panel names. All other information can be monitored and/or retrieved from any installed system.
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&0
w10| Set the Time and Date in the GRX-PRG or GRX-CI-PRG

1. Select Set Time and Date from the Online Options
menu.

2. The current time and date in the Interface Control will be
displayed. If the time or date needs to be modified, type
in the correct information and click the Synchronize button. Do not include the day of the week
when entering the date.

3. Click on Done after the time and date have been set.

EE Check the Status of your System

1. The current status of your system can be viewed by EEEEES ME
selecting System Status from the Online Options T T
menu. The System Status screen will display current = e 2} TocoysErents
. . Address‘ Control Unit Timeclock Events Scene Status
information, such as the currently selected scene at T Corfmanes o |3 Disabied @ Enabd —
each Control Unit. With LIAISON, Timeclock events Z|Lobby 5 Disabled @ Enabled Scens 12

can be enabled and disabled on a Control Unit-by-
Control Unit basis. By disabling the timeclock for a
specific Control Unit, timeclock events will still occur,
but will not affect the specified Control Unit.

2. If a wallstation control has been configured to turn
Timeclock Events on and off (Create or Edit a
Project from File), the Timeclock Status shown in the
System Status screen will be affected. The Timeclock
ON and OFF functions will enable and disable, respectively, the timeclock events of all Control
Units in the system. In addition, DIP Switch 8 (Timeclock ON/OFF) on the GRX-PRG or GRX-
CI-PRG will also affect timeclock status. However, timeclock status cannot be enabled on
any Control Unit if the timeclock has been turned off using DIP Switch 8.

REREENEERC || UTRONLIAISOMDEMO.LIA  3/26/98

3. Click on Done to close the System Status screen.

B

View the Details of your System

The details of your system can be viewed in the System Details screen. System details include
Control Unit model number, software revision (ideal for troubleshooting), communications information,
and temporary mode settings.

1. Select System Details from the Online Options menu.

2. If any changes are made to the system, click Update Details to refresh the list of Control Units.
This feature can be useful during
installation or troubleshooting.

3. Click on Done to close the System Details screen.
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View the Accessory Control Details of your System

The details of the Accessory Controls in your system can be viewed in the Accessory Control Details
screen (include Accessory Control model number, function, and communications information).

IMPORTANT! Accessory Control details are only available from accessory controls with
a minimum code revision. To determine the code revision level, inspect the back of the
accessory control. If you have questions, please contact the Lutron Hotline for assistance.

Minimum Code Revision of Accessory Controls for Getting Details

Type Minimum Code Revision
Standard Accessory Control 2-0
Shade Accessory Control 1-1

1. Select Accessory Controls Details from the Online Options menu.

. B [BdAccessory Control Details - [E]x]
- Click the Accessories tab on the Accessory Control

Details screen to view Accessory details.

Accessolies Controllers

Address M odel Function =
- Click the Controllers tab on the Accessory Control M R -
Details screen to view Controller details. 3 ol per=
. . . . . 5 GRX-AM-GL Group Controller
2. The function is derived from the DIP switch settings B [Motlkod 7 .
of the Accessory Control. Refer to the installation and
instruction sheets of the Accessory Controls for more GRXEMEC  Group Contoler
information.
Channel Control Unit Zone - jate: Details
3. If any changes are made to the system, click ) 7 ] pooun|
. . 2 |4 1 i
Update Details to refresh the list of Accessory Controls. : : - pe_|

This feature can be useful during installation or trouble-
shooting.

4. Click on Done to close the Accessory Control Details screen.

EI Modify Scenes Online

Online Scenes, located in the Online
Options menu, enables you to modify
preset data from your PC. Using your PC,
temporarily adjust your lights through the
familiar GRAFIK Eye Interface to create
new scenes by adjusting fade times and
zone intensities. Use this screen to “tweak”
the light levels in the space, just as you
would use the physical Control Unit.

To adjust the current light levels or make
modifications to presgts, sele_ct Online Tocha gt;“ s sone e u sfoue butons o tpe s
Scenes from the Online Options menu.

Zon refle tth nt intensities in the space. These ma
rotbeth p et forthe t seene.

Any madifications to the light levels using
Online Scenes will make “TEMPORARY
SCENE” the currently selected scene on
the Control Unit. This protects you from
inadvertently changing presets unless you are sure of the modifications. To save a temporary preset,
use the Save Options to select the scene and then press Save.
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NOTE: All preset and system information in online mode is real time and does not require a file to be
opened. Saving a preset in this screen saves the data to the Control Unit in the system. To retrieve
and save this information to a file, refer to Decompile.

m o change the Control Unit being viewed, select from the “Unit Currently Being Monitored” list. The
list of Control Units are the names last programmed using LIAISON.

m To change the current scene of the Control Unit being viewed, select from the “Scene Currently
Selected” list. Remember, the zone intensities shown reflect the current intensities in the space. They
may not be the preset for the current scene if someone has adjusted light levels from an Accessory
Control or directly at the Control Unit.

m Click on Done to close the Online Scenes screen.

El View the Events for Today

m To view the events scheduled for the current day, select RIEEEE AL, i

Today’s Events from the Online Options menu. The
screen will display the current day, what schedule is
to run, and the events in the specified schedule. If any O o ;
. . . . Time of Day ”Q“Astronomlc
events are astronomic, the time the event will occur will T | — [ GrArKeys Ui
be shown followed by an * indicating that the time has 70 AW |SELECT SCENE | A1

&:00AM |SELECT SCENME 2 Al

been calculated based on sunrise or sunset. BODAM | SELECT SCENE 1 Az
1200PM |SEQUEMCE ON B2

m Click on Done to close Today’s Events.

1
23 Monitor the Super Sequence

Eﬂnline Super Seguence

m If a super sequence (Creating or Editing a Project
from File) has been created and transferred, the cur- | Stee R By Wi el itz
rent status of your system can be viewed by selecting memEmsEsmS - e

Online Super Sequence from the Online Options +ISELECTatNE Y a2 T

menu. The Online Super Sequence screen will display |-**EETSEHET Al gsec

the status of the super sequence. Additionally, all steps
of the sequence will be shown, but cannot be edited.

From this screen, the user can start, resume, and stop

the loaded super sequence.

Scene to Select

m Selecting Start will begin the super sequence at the [ BT equence vl un andlooe
first step. If Start is selected while a super sequence '
is running, the super sequence will immediately go to
Step 1 and continue. Selecting Start, for a super sequence that is Paused (see next page), will contin-
ue the super sequence at the next step following the event when the super sequence was Paused.

m Selecting Pause will halt the super sequence at the current step. This function may be ideal in a
showroom application where specific areas are illuminated in a sequential manner and then stepped
through to highlight specific areas.

m Selecting Stop will halt the super sequence. Any Start command or Resume from a Wallstation
Control (Creating or Editing a Project from File) will begin the super sequence at the first step.

Any status change to the super sequence made by a Wallstation Control, will affect the status viewed
in Online Super Sequence.

m Click on Done to close Online Super Sequence.
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View the Power Panels of your System

The details of the power panels in your system can be viewed in the Online Power Panels screen.
Panel details include Control Unit and zone assignment, and load type for each circuit of a panel.

IMPORTANT! Power Panel details are only available from circuit selectors with a code revision
level of 2-50 or newer. The code revision is available on the circuit selector of the panel. If you have
questions, please contact the Lutron Hotline for assistance.

Select Online Power Panels from the Online Options menu. E]Online Power Panels MmE B

. ! Address Code Rev Selec iew loa
LIAISON will search for the first four addresses of power panels. For _ BPCE3-60
each panel located, circuit information will be received. =

Control and Zone Assigned

To check for more panel addresses, click More Panels. LIAISON will Lution [ ConpolUrit| Zane | Load Tupe
search for the next four addresses. I
If any changes are made to the system, click Update Details to S
refresh the Control Unit and Zone and load type assignments. This T e W
feature can be useful during installation or troubleshooting. o
Click on Done to close Online Power Panels.

Communicate with the GRX-PRG or GRX-CI-PRG in Real Time

—

All commands available through the user interface can also be sent using a terminal or equivalent
device. To use the terminal interface available with LIAISON:

Select Terminal from the Online Options menu.

Refer to the GRAFIK Eye RS232 Protocol

help file installed in the LIAISON program group for commands that
can be entered and data that can be received from this screen.

For a complete set of printed commands,

refer to the GRAFIK Eye RS232 Protocol (Lutron P/N 040-138).

=

1 'J
Get System Location Information from the PRG
m Select Location from the Online Options menu.
m LIAISON will display the project location information that was stored in the GRX-PRG or GRX-CI-
PRG.
m Click on Done to close online System Location form.
&iSystem Location ME |
— Syzstem Location
) sen Defined|osation Country State City
% | Selech from defaulbIGeations IUnited States IF'A IPhiIadeIphia
[ Location And Time Zone Data
Latitude: ISS.B M Longitude: |?5.‘I E Time Zone IEastern Tirne ‘
- Daylight Savings Time D ata
Daplight Savings Corection Amaunt I‘I hoawr ‘
Starting Manth IApriI Ending Month IDctober
Starting Day Of week ISunda_l,l Ending Day OF wesk ISunday
Starting Day Of Month IFirst Ending Day OF Month ILast
Starting Time IZ:DD arm Erding Time |2:DD a
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Get After Hours Mode Information from the PRG

m Select After Hours Mode from the Online Options menu.

m LIAISON will display the after hours mode information that
was stored in the GRX-PRG or GRX-CI-PRG.

m Click on Done to close online After Hours Mode form.

Retrieve the Current System Configuration from the GRX-PRG or GRX-CI-PRG

In many instances, the programming of the GRAFIK Eye system may be done using conventional
programming methods instead of LIAISON. Or perhaps, LIAISON may be used for the initial
programming and final adjustments to the lighting are done in the space. In these instances, it would
be desirable to recover the system configuration in a format that could be reviewed or reused at a
later time. Most system information can be recovered; including presets, communication information,
Timeclock events, Super Sequence data, calendar exceptions, and default schedules configuration.
The only data that cannot be retrieved are Accessory Control names, system location, and customer
circuit information. To retrieve the current system configuration:

m Once communication has been established between the PC and the Interface Control, select
Decompile from the Online Options menu. The LIAISON Decompiler screen will contain messages
pertaining to the current status of the retrieval. The first step of decompiling is to select a file name for
saving the configuration. A warning will appear if the file already exists. After retrieving the data, you
will be prompted to switch to Edit Mode. If you would like to view or edit the currently installed sys-
tem, switch to Edit Mode where the decompiled file will be open; otherwise, if additional monitoring to
the system file is desired, remain in the Online Mode.

Finally . . .

Switching between Edit Mode and Online Mode

After starting LIAISON, it is still possible to switch between Create or Edit a Project from File and
Go Online with System modes. From either mode, select the File menu. Depending on the current
mode of operation, select either Go to Online Mode or Go to Edit Mode.
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TERMS AND CONDITIONS

The Grafik Eye LIAISON software is provided “AS IS.” Lutron makes no claims, warranties, or
promises as to its performance. This software is provided without charge.

DISCLAIMER OF WARRANTIES

EXCEPT FOR THE FOREGOING EXPRESS WARRANTY, LUTRON HEREBY DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING,

BUT NOT LIMITED TO, ANY (IF ANY) IMPLIED WARRANTIES, DUTIES OR CONDITIONS

OF MERCHANTABILITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY OR
COMPLETENESS OF RESPONSES, OF RESULTS, OF WORKMANLIKE EFFORT, OF LACK

OF VIRUSES, AND OF LACK OF NEGLIGENCE, ALL WITH REGARD TO THE SOFTWARE,

AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. ALSO, THERE

IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION,
CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH REGARD TO THE
SOFTWARE.

EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL LUTRON

OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOST
PROFITS, LOSS OF DATA, LOSS OF CONFIDENTIAL OR OTHER INFORMATION, BUSINESS
INTERRUPTION, PERSONAL INJURY, LOSS OF PRIVACY, LOST SAVINGS, FAILURE TO MEET
ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE, AND
FOR ANY OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF YOUR USE OR
INABILITY TO USE THE SOFTWARE, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT
SERVICES, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS
LICENSE AGREEMENT; EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE),
STRICT LIABILITY, BREACH OF CONTRACT OR BREACH OF WARRANTY OF LUTRON OR ANY
SUPPLIER; AND EVEN IF LUTRON, OR AN AUTHORIZED LUTRON REPRESENTATIVE OF LUTRON,
OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR
ANY CLAIM BY ANY OTHER PARTY. YOU HAVE THE SOLE RESPONSIBILITY FOR ENSURING
ADEQUATE PROTECTION AND BACKUP OF YOUR DATA USED IN CONNECTION WITH THE
SOFTWARE, AS WELL AS ENSURING ADEQUATE PROTECTION OF THE SOFTWARE AND YOUR
SERVERS, INCLUDING, WITHOUT LIMITATION, SECURING YOUR SERVERS WITH APPROPRIATE
PASSWORDS, FIREWALLS, AND OTHER RESTRICTIONS ON WHO CAN ACCESS THE SERVERS,
THE SOFTWARE, AND THE DATA.

LIMITATION OF LIABILITY AND REMEDIES

NOTWITHSTANDING ANY DAMAGES THAT YOU MIGHT INCUR FOR ANY REASON WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, ALL DAMAGES REFERRED TO ABOVE AND ALL DIRECT

OR GENERAL DAMAGES), THE ENTIRE LIABILITY OF LUTRON AND ANY OF ITS SUPPLIERS
UNDER ANY PROVISION OF THIS LICENSE AGREEMENT AND YOUR EXCLUSIVE REMEDY

FOR ALL OF THE FOREGOING SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU
FOR THIS SOFTWARE, OR U.S. $100.00, AT LUTRON’S SOLE DISCRETION. THE FOREGOING
LIMITATIONS, EXCLUSIONS AND DISCLAIMERS SHALL APPLY TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE.
SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT

APPLY TO YOU. THE WARRANTY CONTAINED IN THIS LICENSE AGREEMENT GIVES YOU
SPECIFIC RIGHTS. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE OR
JURISDICTION TO JURISDICTION.

Lutron and GRAFIK Eye are registered trademarks, and LIAISON is a trademark of Lutron Electronics
Co., Inc.

IBM is a registered trademark of International Business Machines Corporation. Windows and
Microsoft are registered trademarks of Microsoft Corporation. Pentium is a registered trademark of
Intel Corporation.

© 1998-2001 Lutron Electronics Co., Inc.
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